
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

GroupDrive Collaboration Server 
Desktop Client User’s Guide 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
JJJuuulllyyy   222000000888



   

 GroupDrive Desktop Client User’s Guide  ii

Copyrights 

Information in this document is subject to change without notice. The software 
described in this document is furnished under a license agreement, OEM, or reseller 
agreement. The software may be used or copied only in accordance with the terms 
of those agreements. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted in any form or any means electronic or mechanical, 
including photocopying and recording for any purpose other than the purchaser's 
personal use without the written permission of South River Technologies, Inc. 
  
South River Technologies and GroupDrive are registered trademarks of South River 
Technologies, Inc. in the U.S. and other countries. Microsoft, Windows, Windows 
NT, Windows XP, and Windows Vista are registered trademarks of Microsoft 
Corporation, Inc. The names of other actual companies and products mentioned 
herein may be the trademarks of their respective owners. Any information in this 
document about compatible products or services should not be construed in any 
way to suggest SRT endorsement of that product or service. 

 
South River Technologies, Inc. 
179 Admiral Cochrane Drive 
Suite 110 
Annapolis, Maryland 21401 
USA 
Telephone: 410-266-0667 
Fax: 410-266-1191 
www.southrivertech.com 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

http://www.southrivertech.com/
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Contact Information 

 
 

Corporate 
Headquarters 
Address: 

South River Technologies, Inc. 
179 Admiral Cochrane Drive 
Suite 110 
Annapolis, Maryland 21401 
USA 

Main Telephone: 410.266.0667 

Fax: 410.266.1191 

Website: http://www.SouthRiverTechnologies.com 

Sales Inquiries  

Email: sales@southrivertech.com 

Support Inquiries  

Website: www.srthelpdesk.com 
 

http://www.SouthRiverTechnologies.com
mailto:sales@southrivertech.com" 
www.srthelpdesk.com
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Getting Started with GroupDrive Client 

System Requirements   

 
 

 

Operating System 

 

 

Windows Server 2008 (32 or 64-bit)  
Windows Server 2003 (32 or 64-bit)  
Windows Vista Ultimate, Business, or Enterprise 
(32 or 64-bit)  
Windows 2000 Server 
windows 2000 Advanced Server  

   

Processor Minimum Pentium® Class, 2GHz or faster CPU  
Minimum 512MB RAM, 1GB is recommended 

   

Disk Space Minimum 50MB of disk space for the GroupDrive 
program and 100MB for each Server 
configuration 

   

Internet Connection Direct Internet connection or modem with a 
minimum baud rate of 28.8 (56K is 
recommended) 

   

Network Components Microsoft's 32-bit TCP/IP networking component 
 

 
 
 

Make sure all Windows Service Packs and Updates have been 
installed prior to installing GroupDrive. 
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Key Features 

 Access your GroupDrive user space as you would any network drive. You 
can explore and manage your GroupDrive user directory, drag-and-drop 
files and folders to and from your GroupDrive user directory, and even 
work off-line. 

 
 Once you map a drive in Windows to your GroupDrive user space, you can 

edit documents directly using Windows applications like Microsoft Word® 
and Excel®. 

 
 GroupDrive provides the ability to e-mail QuickLinks to files so you can 

securely collaborate over the Internet without the inherent problems of e-
mailing attachments. Many file servers have file size limits that restrict the 
size of files that are e-mailed between users. A GroupDrive QuickLink is a 
special URL that points to a file or folder object, and serves as a shortcut 
to that object. You can use GroupDrive QuickLinks to eliminate the often 
problematic e-mailing of large files. The recipient of the e-mail can simply 
click the QuickLink, included in the body of the e-mail, to access the file or 
folder. 

 
 GroupDrive has built-in SSL (Secure Sockets Layer protocol) support, 

ensuring that all traffic between the GroupDrive server and your computer 
is secure. You can enable SSL encryption with basic or digest 
authentication. You can also configure and manage public key certificates 
using the GroupDrive Certificate Manager. 

 
 You can automate backup and synchronization between your computer 

and the GroupDrive server. Backups can be scheduled to execute daily, 
weekly, or monthly and can run as full or incremental backups.  

 
 The GroupDrive SimulShare feature supports programs that allow block 

level locking. Multiple users can edit different parts of a file at the same 
time because the user can download just a section of the file instead of 
the entire file. This leaves the balance of the file open for other users to 
edit. Multiple users can collaborate in real-time, without being locked out 
of a file and without overwriting another user's changes.  

 
 The GroupDrive Client provides DOS/Legacy support. Once you are 

connected to the GroupDrive Server, you can use a DOS prompt for 
commands such as copy, xcopy, mkdir, dir, move, etc. 
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Terminology 

Cache - The most recently accessed data is stored in a memory buffer. When a 
program needs to access data from the disk, it first checks the disk cache to see if 
the data is there. Disk caching greatly improves the performance of applications 
because accessing a byte of data in memory can be thousands of times faster 
than accessing a byte on a hard disk.  
 
DOS - Acronym for Disk Operating System. The term DOS can refer to any 
operating system, but it is most often used as shorthand for MS-DOS (Microsoft 
Disk Operating System). Originally developed by Microsoft for IBM, MS-DOS was 
the standard operating system for IBM-compatible personal computers.  
 
HTTP - Abbreviation for HyperText Transfer Protocol, the underlying protocol 
used by the World Wide Web. HTTP defines how messages are formatted and 
transmitted, and what actions Web servers and browsers should take in response 
to various commands. 
 
HTTPS - Abbreviation for Secure HyperText Transfer Protocol, the underlying 
secure protocol used by the World Wide Web. GroupDrive uses industry standard 
SSL (Secure Sockets Layer). 
 
ISP - Abbreviation for Internet Service Provider, a company that provides 
access to the Internet.  
 
LAN - Acronym for Local Area Network, a computer network that spans a 
relatively small area. Most LANs are confined to a single building or group of 
buildings. 
 
Permissions - Permissions are set on file and folder objects and determine each 
user's level of access for that object. Permissions are set by the owner of the file 
or folder object. 
 
Proxy Server - A server that acts as a gateway between a client and another 
server (the "real" server). A proxy server sits between the client application and 
the "real" server, and forwards requests to the server. A proxy server intercepts 
all requests to the "real" server to see if the requests should be permitted. If the 
request is permitted, the proxy server will forward the request.  
 
Properties - Refers to the settings and values for specific file and folder objects, 
for example, whether or not the object is shared, or permissions that are set for 
that object.  
 
Root Directory - The top directory in a file system.  
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Select - To click with your mouse on a specific icon, option, or file.  
 
Share - Refers to the process of giving other users access to a file or folder 
object. 
 
SSL - Abbreviation for Secure Sockets Layer; this protocol is used in 
conjunction with another protocol, such a WebDAV or HTTP, to encrypt the 
information that is being transferred between two computers. SSL creates a 
secure tunnel, and another protocol (for example, WebDAV or HTTP) will send its 
transmissions inside of that secure tunnel.  
 
Synchronize - File synchronization is the process of making sure that two or 
more locations contain the same up-to-date files. To configure synchronization 
options, click Properties on the Site Manager, and select General on the 
Properties menu tree. 
 
TCP/IP - Abbreviation for Transmission Control Protocol/Internet Protocol, 
the suite of communications protocols used to connect hosts on the Internet. 
TCP/IP uses several protocols; however, the two primary protocols are TCP and 
IP. TCP/IP is built into the UNIX operating system and is used by the Internet, 
making it the de facto standard for transmitting data over networks. Even network 
operating systems that have their own protocols, such as Netware, also support 
TCP/IP.  
 
UNC - Abbreviation for Universal Naming Convention, UNC is a name format 
used to refer to files on a network share. 
 
URL - Abbreviation for Uniform Resource Locator, the global address of 
documents and other resources on the World Wide Web. The first part of the 
address indicates what protocol to use, and the second part specifies the IP 
address or the domain name where the resource is located. 
 
WebDAV - Acronym for Web-based Distributed Authoring and Versioning 
protocol, an extension to the HTTP protocol that many servers are now supporting 
on the Internet. 
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Installing the GroupDrive Client 

To Install the GroupDrive Client on your Computer 

1. Login to your computer using a user account that has full administrator 
rights. Download or copy the program to your hard drive from the provided 
URL, the server location, or the CD. 

2. Follow the prompts provided in the install wizard. 

3. When the installation is complete, you must restart your computer to use 
the GroupDrive Client. 

To Launch the Application Window 

1.  Double-click the GroupDrive program icon located in the GroupDrive 
program folder created by the installation program -or- 

2.  Right-click the tray icon and select Open GroupDrive. The GroupDrive 
Site Manager Dialog will appear. 

 
 

 To install the GroupDrive Client you must be logged in with a 
user account that has administrator rights. Once installed, 
you can use GroupDrive from any user account. 

 You must restart your computer when the installation is 
complete. 

 

 Questions or Comments? Please visit our online support area at 
http://www.SouthRiverTechnologies.com/support  

 

http://www.SouthRiverTechnologies.com/support
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Tray Icon 

GroupDrive Tray Icon  

When the GroupDrive Desktop Client installation is complete, the GroupDrive 
Client tray icon will appear in your Windows task bar tray area. Much of the 
functionality in the Site Manager also exists via the Tray icon menu. To display 
the tray menu, right-click the tray icon.  

 
 Open GroupDrive - Select to Launch the GroupDrive Site Manager. 

 Program Settings - Select to Launch the GroupDrive Program Settings 
dialog. 

 Connect to - Select the site that you would like to connect to. 

 Show Monitor - Launches the GroupDrive Site Monitor. 

 Run at startup - Click Run at startup to toggle the Run at startup 
option. When a check mark appears next to this option, Run at startup is 
enabled. When this option is enabled, your GroupDrive client will 
automatically start when Windows starts.  

 Help topics - Select to launch the GroupDrive Client Help system. 

 About GroupDrive - Select to view the version number of your 
GroupDrive Client.  

 Current Drive in Use - Displays the current drive in use. 

o Explore Drive - Select this option to explore your GroupDrive 
Client files and folders. 

o Flush Cache - Immediately flushes your GroupDrive cache. 

o Status - Launches the GroupDrive Monitor. 

o Go Offline/Go Online - Allows you to work offline (no active 
connection to the server) or to go online. After you have 
worked offline, you must synchronize your files with the 
GroupDrive server. Use the Site General dialog to configure 
synchronization options. Files must be marked available for 
offline access. 

o Synchronize Now - Click Synchronize Now to immediately 
synchronize your files with the GroupDrive server after you 
have worked offline. 

o Disconnect - Disconnect from the GroupDrive server. 
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Setting up the GroupDrive Client 

Site Manager 

GroupDrive's Site Manager is used to add new sites or edit site information, 
change program settings, and configure various GroupDrive options. The main 
Site Manager window is shown below. You also have the option to use the 
Simplified Site Manager interface, which is a streamlined version of the Site 
Manager. The simplified site manager interface can be enabled from the File 
menu>Program settings>General Settings dialog. 
 

 
 
 

To map your drive to a server: 

1. Click the New Site button. The Site Wizard will launch. 

2. Follow the prompts in the Site Wizard to create a new site. 

3. If you would like to connect immediately, when prompted, select Connect 
to Site now. 

For more information about adding new sites, see the Adding a New Non-Secure 
Site or Adding a New Secure Site topic. 

 
Name: The name of this site. You can also rename a site by using this edit box. 
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Site Address/URL: The URL or site address that you will connect to, for 
example, www.mysitename.com 
 
Server Type: The GroupDrive Collaboration Suite includes the GroupDrive server. 

 
Drive: Select the drive letter to map to the server. 
 
Connect at login/startup: Enable this option if you want the drive to be 
automatically connected to the server when you log on to your computer. 
 
Anonymous/Public Logon: Allows anonymous or public logon. 
 
Username & Password: The username/password for the site. 
 
Connect: Connect and map a drive to the GroupDrive server. 
 
Connect Offline: Map a drive in offline mode; no connection to the server is 
established. Files marked available for offline access will be available to you. You 
will also be able to create new files and folders. You can synchronize your changes 
the next time you connect to the server. 
 
Properties: Displays the Site Properties dialog. 
 
Help:  Launches GroupDrive Help. 
 
New Site:  Launches the GroupDrive Site Wizard. 
 
New Folder: This button creates a new folder in the site list, and allows you to 
group and organize multiple sites into a folder. 
 
Delete: This button deletes the selected site from the site list. 
 
Clone Site: This button creates a duplicate/clone of the currently selected site 
and allows you to rename it. This is useful when you have a site configured with 
custom settings that you want to duplicate for another site. 
 
Save Password: Stores the password internally so that it is automatically 
entered for you each time you log on. 
 
Exit: Closes the Site Manager dialog. 
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Simplified Site Manager  

The simplified Site Manager dialog is used to configure your GroupDrive Client to 
communicate with your GroupDrive server. You can use the simplified Site 
Manager to add new sites or edit site information, change program settings, and 
configure various GroupDrive options. The main simplified Site Manager window 
is shown below. You also have the option to use the more extensive Site Manager 
interface. You can select your Site Manager interface from the File 
menu>Program settings>General Settings dialog. 
 
To access the simplified Site Manager, right-click the GroupDrive Client tray icon 
and select Open GroupDrive. You can also access the Site Manager from the 
Windows start menu by selecting Start>All Programs>GroupDrive. 
 

 
 
 

To map your drive to a server: 

1. Click the Site drop-down arrow and select New. The Site Wizard will 
launch. 

2. Follow the prompts in the Site Wizard to create a new site. 

3. If you would like to connect immediately, when prompted, select Connect 
to Site now.  

For more information about adding new sites, see the Adding a New Non-Secure 
Site or Adding a New Secure Site topic. 
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File Menu: Select the File menu to access Program settings, Export Settings 
to a Registry file, Import Settings to a Registry File, Create Desktop 
shortcut, or to Exit the application. 
 
Utilities: Select the Utilities menu to access the File Transfer Manager or the 
Certificate Manager. 
 
Help: Select the Help menu to launch the GroupDrive Client Help system, or to 
view the GroupDrive Client version number. 

 
Site: Select the drop-down arrow to Add a new site, Edit an existing site, Delete 
a site, or to Clone a site.  
 
Current Site: Use the drop-down arrow to select a different site. 
  
Connect: Click Connect to connect the selected site to the currently displayed 
site. 
 
Connect Offline: This option allows you to map a drive without connecting to the 
server. Any files created will be marked offline and synchronized with the server 
the next time you connect to the server. You will also have access to files 
previously marked offline. Use the Site General dialog to configure 
synchronization options. 
 
Properties: Displays the Properties dialog.  
 
Help: Displays the GroupDrive Help system. 
 
Restore drive at login: When selected, the drive will be automatically connected 
to the server when Windows starts and you have logged on to the workstation. 
 
Secure connection: When enabled, SSL encryption is turned on between the 
GroupDrive Client and the GroupDrive Server. 
 
Username: Your unique user name for logging on to GroupDrive. 
 
Password: Your password for accessing GroupDrive. 
 
Save username/password: When enabled, your user name and password are 
saved in the registry so that you do not have to type them every time you log on 
to the server. 
 
Exit: Closes the Site Manager dialog. 
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Adding a New Site 

To Add a New Site 

1. Open GroupDrive to display the Site Manager dialog. To access 
the Site Manager, right-click the GroupDrive Client tray icon and 
select Open GroupDrive. You can also access the Site Manager 
from the Windows start menu by selecting Start>All 
Programs>GroupDrive. 

2. Click the Site drop-down arrow and select New to launch the Site 
Wizard. 

3. Type a user friendly name for the new site that you will be 
connecting to. This name is used to uniquely identify your site in 
the Site Manager. Use the drop-down arrow to select the Drive 
letter for this site. Click Next. 

4. Type the address/URL for the GroupDrive Server.  

5. The default port for GroupDrive servers is port 80 for non-secure 
connections. To use a non-standard port, clear the check box and 
type your port number. Click Next. 

6. Type your Username and Password. Your username and 
password are supplied by your GroupDrive Server Administrator. If 
you do not want your password to be Saved, clear this check box. 
Click Next. 

7. Select Connect to the Site now if you would like to immediately 
connect to the site. Select Connect at login/startup if you would 
like to connect to the site every time you start your computer. 
Click Finish. 

 
To add a new secure site see the Adding a New Secure Site 
topic. 
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Adding a New Secure Site 

To Add a New Secure Site 

1. Open GroupDrive to display the Site Manager dialog. To access 
the Site Manager, right-click the GroupDrive Client tray icon and 
select Open GroupDrive. You can also access the Site Manager 
from the Windows start menu by selecting Start>All 
Programs>GroupDrive. 

2. Click the Site drop-down arrow and select New to launch the Site 
Wizard. 

3. Type a user friendly name for the new site that you will be 
connecting to. This name is used to uniquely identify your site in 
the Site Manager. Use the drop-down arrow to select the Drive 
letter for this site. Click Next to move to the next step or Cancel 
to discard changes and return to the Site Manager. 

4. Type the address/URL for the GroupDrive Server. For example 
HTTPS://localhost. HTTPS indicates that this will be a secure 
connection. Clear the Use default port check box and type 443 in 
the text box, the default port for secure connections. Click Next.  

5. Use the drop-down arrow to select the public key certificate that 
will be used to authenticate this site when you connect with the 
GroupDrive server. Type the Password for this certificate. The 
password is supplied by your GroupDrive Administrator. To 
configure a certificate for this site, click Certificate Manager. 
Click Next. 

6. Type your Username and Password. Your username and 
password are supplied by your GroupDrive Server Administrator. If 
you do not want your password to be Saved, clear this check box. 
Click Next. 

7. Select Connect to the Site now if you would like to immediately 
connect to the site. Select Connect at login/startup if you would 
like to connect to the site every time you start your computer. 
Click Finish. 

 

 

For more information about configuring SSL & Public Key 
Certificates, see the GroupDrive Desktop Client and Public Key 
Certificate Quick Start Guide. 

 

http://www.SouthRiverTechnologies.com/docs
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Clone a Site 

The Clone Site feature is useful if you need to configure a new site that has many 
of the same configuration settings as another site that you previously configured. 
When you use the Clone feature, your new site will be based on the same 
configuration settings as the site that you choose to clone (copy). You can change 
any of the settings after you create the site. 

To Clone a Site in the Site Manager 

1. Select the site that you would like to clone and click the Clone 
button. 

2. A copy of the site will appear in the site list. Change the name of 
the site and any settings that you would like to be different than 
the site you chose to clone. 

To Clone a Site in the Simplified Site Manager 

1. Open GroupDrive to display the Site Manager dialog. To access 
the Site Manager, right-click the GroupDrive Client tray icon and 
select Open GroupDrive. You can also access the Site Manager 
from the Windows start menu by selecting Start>All 
Programs>GroupDrive. 

2. Use the drop-down arrow to display the site name that you would 
like to copy. Click the Site drop-down arrow and select Clone to 
launch the Site Wizard.  

3. The Site Wizard will display Copy of (the site that you selected to 
clone). Type a name for this new site. Use the drop-down arrow to 
select a Drive for this site. Click Next. 

4. The Site Wizard dialog screens will be based on the configuration 
settings for the site that you have chosen to copy. 

 

 
For more information about adding new sites, see the Adding a 
New Non-Secure Site topic or the Adding a New Secure Site topic. 
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GroupDrive Monitor 

To display the GroupDrive Monitor, right-click the GroupDrive tray icon found in 
the Windows taskbar. Select Show Monitor. 
   
Use the Site drop-down menu to display GroupDrive Monitor options. 
 

 
 

 Open Explorer: Launches Explorer. 

 Always On Top: Keeps the Monitor window always on the top of your 
screen so that it is always visible. 

 Clear Cache: Select Clear Cache to immediately clear the cache listing 
from the log window. You can also use the Clear Cache button. 

 Synchronize Now: Performs immediate synchronization to the server. 

 Go Offline/Online: Work offline or online.  

 Log: 

o Clear Log: Click this button to clear the log list box. 

o Copy to Clipboard: The Clipboard feature copies the contents 
of the monitor dialog box to the Windows clipboard. You can then 
paste the contents into an e-mail or Notepad. 

This is useful for sending information to technical support. 

 Abort File Transfer: Click this button to immediately abort a file transfer. 

 Disconnect: Click the Disconnect button to end your connection with 
the currently displayed network drive.
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Configuring Program Settings 

Program Cache Settings 

The Program Cache Settings dialog allows you to configure the amount of disk 
space to use for the cache and to select the cache folder where all cache files will 
be stored. 
 
To access Cache Settings, launch the Site Manager and select File 
Menu>Program Settings. On the Program Settings tree, select Cache 
Settings. 
 
Configure how much disk space to use for the cache: Specifies the size of 
the cache in megabytes (MB). Use the slider to select a percentage of the drive 
size or type a value in the edit box.  
 
Cache Folder:  Displays the location of the cache folder.  
 
Select Folder: Click to browse and change the folder location. 
 
Clear Cache: Click to immediately clear the cache. You can also clear the cache 
from the GroupDrive Monitor. 
 
Bytes in Use: Displays the current bytes in use. 
 
 
 

 For more information about Caching, see the Caching 
Overview & FAQ topic. 

 For information about Caching, Synchronization, and Offline 
File Access, see the Offline File Access topic.  
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Program Caching Options 

The Program Cache Options dialog allows you to configure caching options. 
 
To access Cache Options, launch the Site Manager and select File 
Menu>Program Settings. On the Program Settings tree, select Options, 
located under Cache Settings. 
 
GroupDrive has many caching options to improve performance. The various 
caching options can be configured from this dialog. Single User mode is the 
default and provides the best performance. Once a file or directory listing is 
cached, it will not be removed from the cache until you connect again or flush the 
cache manually. If you need to see new files that are created on the server, you 
can select Custom mode and configure the directory listings to expire, for 
example, every ten seconds. 
 
Single User (Fastest) - This mode provides the best performance. It assumes 
that files and directory listings that are cached will not be modified by another 
user and will not validate the cached files with the server using the files modified 
time. 
 
Multi-user mode - This mode validates cached files with the server to verify that 
the files are up to date. This way, if a cached file has been modified by another 
user, it will be detected and purged from the cache so that you will receive the 
latest copy of the file.  
 
Custom - This mode allows you to choose custom cache options. 
 
None - This mode disables file and directory listing caching. Files will still be 
temporarily cached so that applications that perform random access to the file 
data will work, but the next time the application opens the file, it will download a 
fresh copy from the server. 
 
Cache Files - Save files in the cache folder for quicker access. 
 
Validate cached files with servers modified time - Validates that a cached 
file is up to date by checking the modified time of the cache file with the modified 
time on the server. While this option ensures that a file or listing is up to date, it 
does affect performance. 
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Expire cached files after (X) Seconds - Causes a file that has been cached 
longer than (X) seconds to be considered expired so that it will be removed from 
the cache when accessed and a new file will be downloaded from the server. 
Normally it is not necessary to enable this feature because GroupDrive 
automatically checks to see if cache files are up to date before using them.  
 
Cache Directory listings - Store directory listings in the cache folder for quicker 
directory and file access. 
 
Validate cached directory listings with servers modified time - Validates 
that a cached directory listing is up to date by checking the modified time of the 
cache file with the modified time on the server. 
 
Expire cached listings after (X) Seconds - Causes a directory listing that has 
been cached longer than (X) seconds to be considered expired so that it will be 
removed from the cache when accessed and a new directory listing will be 
downloaded from the server. Enable this setting if you want to see changes from 
other users without having to manually flush the cache.  
 
Flush cache files on connect - When enabled, this feature will delete files in the 
cache at connect time. Normally it is not necessary to enable this option because 
GroupDrive will automatically check to see if cached files are up to date before 
using them. 
 
Flush directory listings on connect - When enabled, this feature will delete 
files in the cache at connect time. Normally it is not necessary to enable this 
option because GroupDrive will automatically check to see if cache files are up to 
date before using them. 
 
 

 So that your files will show up immediately when you connect 
in Online Mode, you can set your Cache Options to Multi-User 
Mode, or set them to Custom Mode and turn off Directory 
Caching. This will ensure that the desktop client will query 
the remote server for new information whenever it needs it. 

 For more information about Caching, see the Caching 
Overview & FAQ topic. 

 For information about Caching, Synchronization, and Offline 
File Access, see the Offline File Access topic.  
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Program Logging Settings 

The Program Logging dialog allows you to log server command/responses to a 
file. 

 

To access the Logging settings launch the Site Manager and select File 
Menu>Program Settings. On the Program Settings tree, select Logging. 

 

Enable file logging: Logs connection information to a log file. 
  

Folder to store log files in: Select the folder where log files are stored. The log 
filename will be the name of the site with a .log extension. 

 

General Options 

 

Truncate log file on each connect: When enabled, clears out the log file each 
time you connect to the server. 

 

Detailed Options 

 

Log informational messages: When enabled, log informational messages will 
log significant non-error events where no user action is required. 

 

Log verbose information: When enabled, detailed information including the 
type of message, text of the message, the cause of the condition leading to the 
message, and any recommended action will be logged. You can enable verbose 
logging to help troubleshoot technical problems.  

 

Log file I/O information: When enabled, all file system calls to the drive will be 
logged, these include reads/writes/creates/closes, etc. 

 

Log protocol traffic to server: When enabled, protocol traffic to the server will 
be logged.  

 

Log detailed protocol traffic to server: When enabled, detailed information 
about protocol traffic to the server will be logged; including the date and time of 
the request, the number of bytes sent, and the action taken. Detailed protocol 
logging may be helpful to detect suspicious activity or certain hacking attempts.  

 

Log debug information: When enabled, the debug log file contains status and 
error messages useful for diagnosing errors and debugging.  
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Generally, you only need to enable advanced logging options when 
you are debugging a specific issue. 
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Program Popup Window Settings 

Use the Program Popup Window to configure a pop-up window that will display 
the file transfer status, serious errors, and synchronization status. For example, 
you can configure the pop-up window to alert you when an upload fails. The Pop-
up window will display messages near the taskbar tray. 
 
To access pop-up window settings, launch the Site Manager and select File 
Menu> Program Settings. On the Program Settings menu tree, select Popup 
Window.  
 
Enable Popup Window:  Select the check box to enable the pop-up window for 
file transfer status and error information. 
 
Configure Popup Window: Click Popup Settings to configure the appearance 
of the pop-up window and display options. 
 
Popup Settings 
 
Transparency - Use the slider to configure the transparency of the pop-up 
window. 
 
Duration - Use the slider to configure the amount of time that the window will 
stay visible, how long the window fade-in will last, and how long the window fade-
out will last. 
 
File Transfer  
 

 Display File Transfer Popup Window - When enabled, a pop-up 
window is displayed during file transfers. 

 Only display for file sizes larger than X KB - Set the file size using the 
up/down arrows or by typing the file size. 

 Don't display for transfers by File Transfer Manager - When enabled, 
the pop-up window will not be displayed during transfers that are initiated 
by the File Transfer Manager. 



           
          

 GroupDrive Desktop Client User’s Guide  26 

Program Backup Files Settings 

Use the Program Backup Files Settings dialog to configure where backup files are 
stored if an upload failure occurs. GroupDrive will create a backup of a file when 
an upload failure occurs so that you do not lose changes to documents. 

To access Backup Files settings, launch the Site Manager and select File 
Menu>Program Settings. On the Program Settings menu tree, click Backup 
Files. Select the check box to enable Backup files if upload fails. Click Select 
Folder to change the location of the backup files. 

Program General Settings 

The Program General Settings dialog allows you to customize various program 
options.  
 
To access General Settings, launch the Site Manager and select File > Program 
Settings. On the Program Settings menu tree, select General Settings. 
 
Basic Settings 
 
Open Explorer after connecting: When selected, an Explorer window is opened 
when a drive is mapped to a site.  
 
Open Explorer in folder View mode: Controls how the Explorer window is 
opened after a connection is established. When the folder view mode is enabled, 
the Explorer window will contain only one pane that contains the folder of files. 
 
Run in taskbar tray at startup: When selected, the program will start 
automatically when you log on to your computer and the GroupDrive tray icon will 
be displayed. 
 
Display Monitor after connecting: When selected, the Drive Monitor dialog will 
be displayed after you connect to the server. 
 
Use simplified Site Manager Dialog: When selected, the program displays the 
smaller and more simplified Site manager dialog. 
 
Prompt for password on failed logins: When selected, if the user's logon fails, 
the user will be prompted to type a password. 
 
Display errors in popup dialog: When selected, a pop-up window will appear to 
provide error message information. 
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Always open Site Manager dialog on tray icon double click: When selected, 
this option will allow you to launch GroupDrive's Site Manager by double-clicking 
the GroupDrive tray icon. 
 
Advanced Settings 
 
Display custom drive icon in Explorer: When selected, the program displays a 
custom drive icon in Explorer for connected drives. Clear the check box to use the 
standard drive icon. 
 
Automatically select drive to use: When selected, the program automatically 
selects the next available drive when connecting to server. 
 
Set persistent drives to disconnected state at startup: When selected, you 
can define persistent connections, but when the system starts, they will not 
automatically be connected. The persistent connections are displayed in the 
Explorer window as disconnected drives. To connect to the remote server simply 
double-click on the drive. 
 
Disable shell column handlers: When selected, shell column handlers are 
disabled. Windows 2000 and beyond has a feature called Column Handlers that 
allows Explorer to add extra columns of information in addition to the file name. 
This could include information such as the file author and other information about 
the file. This extra information is displayed when you click on a file in Explorer. 
 
Disable DFS: When selected, disables distributed file system support. 
 
Enable delayed close for open files:  When selected, the program keeps files 
open for a short time after the application closes it, in case the application opens 
it again. This performance enhancement can be useful when files are repeatedly 
opened and closed when you are reading data from them. 
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Certificate Management 

The Program Certificate Management dialog allows you to configure an SSL 
certificate to use when you connect to the server, and to select where the 
certificate store is located. 
 
To access Certificate Management, launch the Site Manager and from the File 
menu, select Program Settings. On the Program Settings menu tree, select 
Certificate Management.  
 
Certificate Store Folder - Use the browse "..." button to browse the location of 
the certificate store folder. 
 
Certificate Manager - Click Certificate Manager to launch the Certificate 
Manager. Use the Certificate Manager to create, import, and manage certificates. 
 

 Delete:  Deletes the selected Certificate from the Certificate store. 

 Export:  Exports the selected Certificate. 

 Sign CSR:  Displays the certificate signing wizard. 

 Properties:  Displays the certificate properties. 

 Create:  Create a new certificate. 

 Import:  Import a certificate into the certificate store. 

 
Public Key Certificate Best Practices 
 
Each entity in a secure environment, both the client and the server, should 
generate its own key pair. This key pair will have a public key and a 
corresponding private key. Never share or send your private key to anyone 
because this will compromise the integrity of your key pair. It is always a good 
practice to also password protect your private key, and GroupDrive requires this. 
 
The GroupDrive client’s public key certificate must be provided to the GroupDrive 
Server Administrator to be installed on the server. While it is possible to use the 
Certificate Management features in GroupDrive to export your private key, it is 
highly discouraged unless it is for backup purposes, because it is difficult to 
ensure the integrity of the private key during the physical transfer of the key file. 
If it is necessary to export the private key, it is recommended that the transfer be 
performed over a secure medium. You can export the keys to an encrypted USB 
drive, or encrypt the files onto a DVD/CDROM; however, never e-mail the private 
key. E-mail is natively insecure and there is no way to ensure the integrity of the 
files during electronic transfer.  
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For more information about configuring SSL & Public Key 
Certificates, see the GroupDrive Desktop Client Public Key 
Certificate Quick Start Guide. 

 

http://www.southrivertechnologies.com/docs
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Proxy Dialog 

Use the Program Proxy HTTP Settings dialog to configure the use of a proxy 
server. To access the Proxy HTTP dialog, launch the Site Manager and from the 
File menu select Program Settings. On the Program Settings tree, select 
Proxy HTTP. 
 
Enable proxy server: When selected, enables logon through a firewall/proxy 
server. 
 
Proxy type: Use the drop-down menu to select your Proxy server type. 
 

 HTTP Standard (CERN): This is the most common type of proxy server. 

 HTTP Tunnel: This uses the HTTP tunneling protocol to establish a 
connection to the remote site. 

 This is generally used for SSL (Secure Sockets Layer) proxies; 
however, you may find this useful if the program does not work with the 
proxy server type set to CERN. 

 HTTP Port Forwarding (SSH): This method can be used for SSH port 
forwarding. It will connect to the specified address and expect the server 
listening on this port to forward the connection to the desired remote 
server. F-Secure SSH client can be used under Windows NT/2000 to SSH 
encrypt communications. 

 
Proxy server address: Type the URL (Uniform Resource Locator), the global 
address of resources on the World Wide Web or IP (Internet Protocol) address of 
your proxy server. 
 
Port: Type the port number for your proxy server. The default port is 8080; other 
common port numbers for HTTP proxies are 8888 and 8000. 
 
Proxy server username: Some proxy servers require a username. Leave this 
text box empty if your proxy server does not require a username. 
 
Proxy server password: Type the password for your proxy server, if required. If 
no password is required, leave this text box empty. 
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Configuring Site Settings 

Site General Dialog 

You can use the General dialog to configure general settings for a site. 
 
To access the General dialog tab, launch the GroupDrive Site Manager and then 
click Properties. On the Properties menu tree, click General.  
 
Open Explorer in the following folder: Opens Explorer in the specified folder 
on the remote site. 
 
Make drive read-only: Select this check box to mark all files on the site as read-
only so that you cannot accidentally make changes to the files. 
 
Synchronize Offline files at Connect time: Select this check box to 
synchronize with the server, when you connect, all files marked as Offline. 
 
Synchronize Offline files at Disconnect time: Select this check box to 
synchronize with the server, when you disconnect, all files marked as Offline. 

Site Connection Dialog  

You can use the site Connection dialog to configure connection settings for a 
site. 
 
To access the site Connection dialog, launch the GroupDrive Site Manager, and 
then click Properties. On the Properties menu tree, click Connection to 
configure connection settings. 
 
Bypass proxy server for this Site: Select this check box if you have a proxy 
server configured, but you do not need to go through the proxy server for this 
specific site. This setting is typically used for internal LAN connections. 
 
Command timeout: Specify the number of seconds to wait for the server to 
respond to a command before timing out. 
 
Connection Port: Specify the port to connect to the server on. You can typically 
leave this box empty to have GroupDrive select the default port for the protocol in 
use. 
 
Failed transfer retry count: Specify the number of times to retry a failed 
upload/download request. 
 



 

 GroupDrive Desktop Client User’s Guide  32 

Active Connection Limit: Select the maximum number of simultaneous 
connections that GroupDrive will use to connect to the server. Initially GroupDrive 
will only establish a single connection to the server; however, if one connection is 
busy transferring a file, GroupDrive will attempt to establish another connection if 
another file transfer or directory listing transfer is required. Use this setting to 
limit the number of connections that GroupDrive will attempt to use. 
 
Active Upload Limit: Select the maximum number of simultaneous uploads that 
GroupDrive will use. Generally, you should set this amount to a lower amount 
than the Active Connection Limit so that other operations can also occur when 
uploading multiple files. 
 

Site HTTP Settings 

You can use the site HTTP Settings dialog to configure HTTP settings for a site. 
 
To access the site HTTP Settings dialog, launch the GroupDrive Site Manager, 
and then click Properties. On the Properties menu tree, click HTTP Settings to 
configure HTTP settings. 
 
Always choose Basic Authentication: When enabled, GroupDrive will use 
Basic Authentication. Basic authentication is faster but less secure. 
 
Enable persistent connections:  Enables HTTP keep-alive, this is highly 
recommended because it increases performance significantly. 
 

Site Certificate Dialog 

The site Security Certificate dialog allows you to select an SSL certificate to use 
when you connect to the server. To access the site Certificate dialog, launch the 
GroupDrive Site Manager and click Properties. On the Properties menu tree, 
click Certificate. 
 
Select the Certificate from the drop-down list and then type the password for 
the certificate. The certificate must have already been imported by GroupDrive. 
 

 
For information about configuring Public Key Certificates, see the 
GroupDrive Desktop Client Public Key Certificate Quick Start Guide. 

 
 

http://www.SouthRiverTechnologies.com/docs
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Site SSL Encryption Dialog 

Use the site Encryption dialog to configure the SSL encryption method when 
connecting securely to the server. To access the Encryption dialog, launch the 
GroupDrive Site Manager and click Properties. On the Properties menu tree, 
select Encryption, located under Security. 
 
To configure the encryption method, select SSL from the drop-down list. 
 

Site File Settings Dialog 

Use the site File dialog to configure various options for filenames for the server. 
To access the site File settings dialog, launch the Site Manager, and then click 
Properties. On the Properties menu tree, select File.  
 
Basic File Options 
Encode filenames in UTF-8: Encode filenames before sending them to the 
server in UTF-8. 
 
Cache temporary MS Office files: Microsoft Word and Excel use temporary files 
when editing .doc or .xls files. Enable this option to have these temporary files 
cached instead of being uploaded to the server. This will save time when you edit 
.doc or .xls files; when you save the document it will only be uploaded to the 
server when the temporary file is renamed into the original .doc or .xls file. 
 
Ignore Desktop.ini files (assume they don't exist): Always return File Not 
Found when Explorer tries to open desktop.ini files. Explorer attempts to open 
desktop.ini files when browsing folders and this can slow down operations.  
 
Enable NTFS File Security (for applications requiring NT security): Returns 
simulated NTFS permissions information for applications that require it, for 
example, WordPerfect.  
 
Perform Cache File Read Ahead: Enable this option to perform read-ahead 
operations on files for better performance.  
 
Cache small writes by applications: Enable this option to cache and combine 
small writes by applications into larger writes. Some applications issue very small 
writes, for example, one byte at a time, even when writing a very large file. 
Enabling this setting can greatly increase performance for these applications. 
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Stop file downloads when application closes the file before reading all 
data: When enabled, this option stops file downloads that are in progress when 
the application that opened and read from the file has stopped reading data. This 
is useful for preventing download of very large files when the application only 
reads the first few bytes of the file. For example, Explorer often does this when 
browsing folders. 
 
Enable Quota Processing: When quota processing is enabled on the server, file 
writes will fail if quota is exceeded.  
 
Disable Explorer icon handler to prevent file download: Prevents files from 
being downloaded so that icons cannot be extracted, for example, .html, .zip. 
 

Site Cache Settings Dialog 

Use the site Cache dialog to configure whether or not this site will use the global 
cache settings for all sites, or if it will override the global cache settings with 
custom cache settings that only apply to this site. This is useful for sites that 
require specific caching options that may not necessarily apply to most of your 
sites. 
 
To access the Cache settings dialog, launch the Site Manager and then click 
Properties. From the Properties menu tree, select Cache. 
 

Use the drop-down arrow to configure the cache settings: 

 Use global cache settings 

 Override global settings 

Site Advanced Dialog 

Use the site Advanced dialog to configure advanced site settings. 
 
To access the Advanced site settings dialog, launch the Site Manager and then 
click Properties. On the Properties menu tree, select Advanced. 
 
Enable Custom UNC name for this Site: Allows you to define a custom UNC 
name for the site.  

Allow NT Services to access mapped drive: Maps the drive under the NT 
LocalSystem context that allows services like IIS (Microsoft Internet Information 
Services) to access the mapped drive letter. 

Map drive at system startup: Maps the drive at system start, not user login. 
This may be useful when NT services need access to the drive.
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Using Your GroupDrive Client 

Connecting to your GroupDrive 

To access a GroupDrive Server you need the URL or address of the server and a 
user account on the server. These will be supplied to you by your GroupDrive 
System Administrator. Once you create the site that you wish to connect to using 
the Site Wizard and specify the server to connect to in the Site Manager dialog, 
you simply select Connect. The new drive letter that you chose will be available 
on your Windows Explorer. Once you successfully connect to your GroupDrive, 
you can open Explorer and your GroupDrive files will be visible and accessible. 

Storing Files 

Each user is assigned a user directory on the GroupDrive Server. This is where 
you will store and retrieve files and folders. 

 To store files or folders in your GroupDrive user directory 

1. Right-click on the GroupDrive tray icon and select Open 
GroupDrive. The GroupDrive Site Manager will be displayed. 

2. Use the drop-down arrow to select the site name that you wish to 
connect to. 

3. Click Connect. Your GroupDrive user directory will be displayed in 
the Explorer window. 

You can now store the files or folders on your GroupDrive user directory in the 
same manner that you would when using any Windows application. 
 
 You may either: 

 Drag and drop the file or folder from its current location to your 
GroupDrive user directory. 

 Right-click the file or folder in its current location and select Copy, and 
then click within your GroupDrive user directory and select Paste. 

 Right-click the file or folder in its current location and select Cut, and then 
click within your GroupDrive user directory and select Paste. 

 Use the File Open/Save As dialog from any Windows or DOS application 
to store or access files or folders on your GroupDrive.  

Once you have stored files or folders are in your GroupDrive user directory, you 
can access them from any location from which you can sign on to the GroupDrive 
Server. 
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Sharing Files & Folders 

To share your file or folder objects with other users you must enable Sharing for 
the object and set Permissions for that object. 

Sharing & Permissions  

Every folder object and every file object in the GroupDrive file system has an 
access control list (ACL) associated with it that defines which users or groups 
have access to these objects. An access control list is comprised of one or more 
access control entries (ACE) that define the access permissions for a specific 
user or group. 
 
If you would like another user to have access to your file or folder object, you 
must first enable Sharing for that object and then set Permissions, using an 
access control entry, to specify a user's level of access to the object. For 
example, you can set permissions on a file to let one user read the contents of a 
file, let another user make changes to the file, and prevent all other users from 
accessing the file.  
 
We recommend that you read the Sharing, Linking, and Permissions Overview 
topic before you share a file. 

 To Share File and Folder Objects & Set Permissions 

1. From your GroupDrive directory, right-click the file or folder object that 
you want to share. 

2. Select Properties. 

3. Select the Sharing tab. 

4. Select Share this object. 

5. Type a Comment to identify the shared file or folder. 

6. Click OK. 

7. Select the Permissions tab to view the Access Control List (ACL) for this 
file or folder object. 

8. Click Add to add users or groups to the ACL. The Select Users or 
Groups window will appear. Select the user or groups. To select more 
than one user or groups, hold the Ctrl key as you click with your mouse. 
When you are satisfied with your selection, click Add and then click OK.
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9. To change or set Permissions, select the group or user and enable 
Replace permissions on all child objects with the entries shown 
here. Select the File/Folder Permissions. When you are finished, click 
OK. 

 
After you enable sharing for a file or folder object and set permissions, you can e-
mail a link to users to notify them that the object has been shared. 
 
 

 If you intend to share multiple files in the same folder, it is 
usually easier to share the entire folder so that the other 
collaborators can link to a single folder instead of each 
individual file. 

 It is a good practice to assign permissions to groups because it 
improves system performance when verifying the user's access 
to files. 
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Accessing Shared Files 

To gain access to a file or folder object that another user has shared with you, you 
must create a link to that object in your own directory space. You can then 
access the shared files and folders in your own directory tree as if they were on 
your own directory space. The user that has shared the file or folder object with 
you will grant permissions that specify your level of access to that file or folder 
object. 

 

We recommend that you read the Sharing, Linking, and Permissions Overview 
topic. 

To Link To a File or Folder that has been Shared with You 

1. Select the drive icon from Explorer. 

2. Right-click on the drive or folder and a context menu will be displayed. 

3. Select Properties from the menu and the Properties dialog will be 
displayed. 

4. Select the Link To tab. 

5. Select the file or folder object that you wish to link to. The Link Name 
text box will automatically be populated with the path of the file or folder 
object. Alternatively, you may type the path in the Link name text box. 

6. Click Add. 

7. Click OK. 

 
You can now access the shared items in your own GroupDrive directory tree. 
Permissions for the file or folder object that has been shared with you are set by 
the user that has shared the file or folder object with you.
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Collaborating with Others 

GroupDrive features allow users, in the same office or around the world, to 
collaborate on files at the same time. Users can easily create shared workspaces 
and the creator of the workspace can define the actions that other users can take 
on the documents and folders in the workspace. Multiple users can work on the 
same document at the same time by using block level access features in programs 
that support block level editing. Documents can also be shared with other users or 
people outside of your organization by sending QuickLinks rather than bulky e-
mail attachments. Because your files are stored in a central location, users always 
have the most current version of a document.  

GroupDrive SimulShare/Block Level Access 

GroupDrive supports programs that allow block level locking, for example, 
Microsoft Access®. Multiple users can edit different parts of the file at the same 
time because a user can download just a section of the file, instead of the whole 
file. This leaves the balance of the file open for other users to edit. This allows 
multiple users to collaborate in real-time, without being locked out of a file, and 
without overwriting another user's changes. 

Share Files & Folders 

To collaborate with other users or groups of users, you can share the file or folder 
that contains the document. When sharing a file or folder object, you set 
permissions to specify what actions or operations the collaborating users will have 
access to. For example, you can share a document with other users, but only 
allow them Read access to the document. They can then open and view the 
document, but cannot make any changes. 

QuickLinks 

GroupDrive provides the ability to e-mail QuickLinks to files. A GroupDrive 
QuickLink is a special URL that points to a file or folder. You can think of a 
QuickLink as a shortcut to a file or folder. Many file servers have file size limits 
that can restrict the size of file that are e-mailed between users. QuickLinks 
eliminate the often problematic e-mailing of large files. The recipient of the e-mail 
can simply click the QuickLink, included in the body of the e-mail, to access the 
file or folder. 
 

We recommend that you read the Sharing, Linking, and Permissions 
Overview topic. 
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Disconnecting a Drive 

There are several ways to disconnect a mapped drive in GroupDrive. 
 

 Disconnect from the tray icon  

1. Right-click the tray icon. 

2. Select the site that the drive is connected to. 

3. Select Disconnect.  
 

 Disconnect from Explorer 

1. Right-click Start. 

2. Select Explore. 

3. Select the drive to disconnect. 

4. Select Tools >Disconnect Network Drive.  
 

 Disconnect from Explorer  

1. Right-click Start. 

2. Select Explore. 

3. Select a drive. 

4. Select Disconnect. 
 

The Remove button on the Site Manager dialog removes/deletes the site 
information from the registry; however, it does not disconnect the drive if it is 
active.   
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Disconnecting from your GroupDrive 

There are several ways to disconnect from the GroupDrive Server.  

To Disconnect from the GroupDrive Server 

Select the Disconnect button from Explorer,  

-or- 

Right-click the drive icon in Explorer and then select Disconnect, 

-or- 

Select Disconnect from the Monitor Dialog. 

 

Offline File Access 

Offline Synchronization Overview 

The GroupDrive Desktop client has a powerful feature that allows you to mark 
files and/or folders Available for Offline Access. When you work in Offline 
Mode, you can edit and create files even when you are not connected to the 
server. This means that you can “unplug” your computer from the Internet and 
still access files through the mapped drive. The desktop client will remember all 
changes that you make to existing files, new files that you create, and files that 
you delete. When you reconnect in Online mode, synchronization will be 
performed and any changes will be synchronized between the server and your 
computer. This feature can be used extensively to ensure that you can always 
have access to any file or folder objects that you have marked Available for 
Offline Access. 

New files created locally while offline – Any new files that you create locally 
while you are working offline will be transferred to the remote server during the 
synchronization process, provided that the folder in which these files are stored 
has been marked for offline access.
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Existing files modified locally while offline – Any existing files that you 
modified locally while working offline will be transferred to the remote server 
during the synchronization process, provided that the folder in which these files 
are stored, or the file itself, has been marked for offline access. During the 
synchronization process, the desktop client will check the date, time, and file size 
of the local and remote versions of the file, to see if the local file should be 
uploaded to the server. If the server version of the file has not changed since the 
local copy was used, then the local copy will be uploaded and will replace the old 
version stored on the server. If the local file has changed, but the remote file has 
also changed, the desktop client will rename file on the server before uploading 
the local copy. If this happens, a message box will be displayed so that you can 
manually check for differences in the local vs. remote versions. The desktop client 
does not perform automatic merging of changes between local and remote 
versions. 

Existing files deleted locally while offline – Any existing file that you deleted 
locally while working offline will be deleted from the remote server during the 
synchronization process, provided that the folder in which these files are stored, 
or the file itself, has been marked for offline access. 

Configuring your GroupDrive client 

To access Synchronization Configuration Settings, launch the Site Manager 
and click Properties. In the Properties menu tree, click General.  

There are two synchronization settings. Enable both settings for full 
synchronization. Failure to enable both features may result in some files not being 
synchronized correctly. 

 

 Synchronize Offline files at Connect time – Enable this option to 
have the Desktop Client synchronize all offline files with the remote 
GroupDrive Server each time you connect to the server in Online 
Mode. When this option is enabled, the Desktop Client will perform 
an automatic synchronization with the remote server immediately 
after the drive has been mapped and your username and password 
have been authenticated against the remote server. 

 

 Synchronize Offline files at Disconnect time – Enable this 
option to have the Desktop Client synchronize all offline files with 
the remote GroupDrive Server each time you disconnect from the 
server when you are in Online Mode. 
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To Work in Offline Mode 

You must mark the file for offline access while you are connected to the server. 
 
To mark the file for offline access, right-click on file and select 
GroupDrive>Make Available Offline. The file will then be cached locally so that 
you will have access to it while offline. Any changes that are made offline can 
later be synchronized with the server when you connect to it.  
 
Note: Make sure that the Connect Offline option is not enabled at this time. 
When selecting files/folders for offline access, you must connect to the remote 
GroupDrive Server in Online Mode. 
 
Once you have configured your GroupDrive client and marked your files, you are 
ready to move to offline mode. Connecting in Offline mode is simply a matter of 
mapping the drive while the Connect Offline option is enabled. 
 
To connect offline, launch the Site Manager and use the check box enable the 
Connect Offline option. Click Connect to map the GroupDrive and connect in 
offline mode. Once you are connected in offline mode, the GroupDrive Site 
Manager dialog will close and Windows Explorer will open, displaying the contents 
of your mapped drive. 
 
 

 If you select Synchronize Now, your files will be immediately 
synchronized to the server even if you are offline. 

 So that your files will show up immediately when you connect 
in Online Mode, you can set your Cache Options to Multi-
User Mode, or set them to Custom Mode and turn off 
Directory Caching. This will ensure that the desktop client 
will query the remote server for new information whenever it 
needs it. 

 For more information about Offline File Access, see the 
GroupDrive Offline File Access and Synchronization Features 
white paper.  

 For more information about Caching, see the Caching 
Overview & FAQ topic. 

http://southrivertech.com/docs
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File Menu 

File Menu 

The GroupDrive Client File Menu contains several options. 
 

 Program Settings: Displays the Program Settings dialog. 

 

 Export settings to a registry file: Exports the settings used by the 
GroupDrive Client to a registry file so that you can later import them on 
another machine. Note: This is a good way to back up your GroupDrive 
Client configuration. 

 

 Import settings from a registry file: Imports the settings from a 
registry file that was exported using the option above. 

 

 Create Desktop Shortcut: Creates a shortcut for the currently selected 
item on the desktop. You can then double-click on the shortcut to connect 
to the site. 

 

 Exit: Exits the GroupDrive Client. 
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Export Settings to a Registry File 

The Export Settings dialog can be used to save your application and site 
information to a registry file. This registry file can be imported on another 
machine. The registry settings file can also be imported by the setup application. 
This provides system administrators with a way to pre-configure the software 
when it is installed on several computers in an organization.  

 

To Export Settings 

1. Select File > Export settings to registry file. The Export Settings 
dialog will be displayed. 

 

 

 

2. Select the check box to select Export Site Database to export the 
site/connection listings. 

3. Select the check box to select Export User Settings to export the 
program settings. 

4. Type the Filename to export to, or click Browse to browse the files. 

5. Click OK. 
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Import Settings from a Registry File 

The Import Settings dialog can be used to import a registry file that contains 
application and site settings information. This feature is useful for transferring 
settings from one computer to another. 
 

To Import Settings from a Registry File 

1. Select File > Import settings from a registry file. The Import 
Settings dialog will appear. 

 

 
 
 

2. Type the Filename to import, or click Browse to browse the displayed 
files and then double-click to select the desired file.   

3. Click OK.
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Utilities Menu 

File Transfer Manager 

The GroupDrive File Transfer Manager can be used to back up or synchronize 
remote folders or entire Web sites. To access the File Transfer Manager, launch 
the GroupDrive Site Manager. From the Utilities menu, click File Transfer 
Manager. The GroupDrive File Transfer Manager will launch. Click New or click 
the File Set Name to launch the File Transfer Wizard. 
 
Use the File Transfer Manager to: 
 

 Perform full or incremental backups from local files or folders to a server. 

 Synchronize files and folders between your local computer and your 
server. 

 Download files/folders from your server to your local computer. 

 Schedule backup or synchronization jobs to run periodically or at specific 
times.  
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Certificate Manager 

The Certificate Manager allows you to configure an SSL certificate to use when 
you connect to the server, and to select where the certificate store is located. To 
access the Certificate Manager, launch the GroupDrive Site Manager. From the 
Utilities menu, select Certificate Manager. You can also access the Certificate 
Manager from the Program Settings menu. 
 
 

For more information about configuring SSL & Public Key 
Certificates, read the Program Certificate Manager topic or see the 
GroupDrive Desktop Client Public Key Certificate Quick Start Guide. 
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Advanced Topics 

Caching Overview & FAQ 

You can configure your most recently accessed data to be stored in a memory 
buffer, referred to as the cache. When a program needs to access data from the 
disk, it first checks the disk cache to see if the data is there. Disk caching greatly 
improves the performance of applications because accessing a byte of data in 
memory can be thousands of times faster than accessing a byte on a hard disk.  
 
GroupDrive supports caching for both file and directory listings. You control the 
amount of disk space the cache will use and whether to cache files, directory 
listings, or both.  
 
Caching Modes 

There are three caching modes available in GroupDrive, Single-User, Multi-
User, and Custom. In Single-User mode, once a file or directory listing is 
cached, it will remain in the cache until it is flushed manually and GroupDrive will 
not validate the date/time of the cache file against the server. This is the fastest 
mode; however, if you have multiple users editing files on your server you may 
not see updates from the other users. You can also turn off caching by configuring 
your caching options to None. If you configure your caching options to None, 
GroupDrive will download files from the server on each access by an application. 
 
Cache Temporary MS Office files 

Microsoft Word and Excel use temporary files when editing .doc or .xls files. You 
can enable the Cache Temporary MS Office Files option to have these 
temporary files cached instead of being uploaded to the server. This will save time 
when you edit these types of files; when you save the document it will only be 
uploaded to the server when the temporary file is renamed into the original .doc 
or .xls file. Use the site File dialog to configure this option. To access the site File 
settings dialog, launch the Site Manager, and then click Properties. On the 
Properties menu tree, select File.  
 
Cache Size 
The amount of disk space to use for caching can be configured from the Cache 
Settings dialog. You should select a size that is at least as large as the largest file 
you intend to use. Files are flushed from the cache when the cache size is about 
to overflow the cache limit. If a file is too large to fit in the cache, it will 
temporarily exceed the cache limit but remove the file from the cache when it is 
closed by the application.
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 For more information about cache settings see the Program 
Cache Settings and Program Cache Options topics. 

 For more information about Caching, Synchronization, and 
Offline File Access, see the Offline File Access topic.  

 

Caching FAQ 

Does GroupDrive mirror data by default? 
 
GroupDrive, by default, does not mirror all the remote data with the local data, it 
stores all data remotely. Only when a user requests the data is it then copied 
locally into cache. Once the user saves the changes, those changes are 
immediately sent back to the remote server. 
 
My file listing using the client does not display the same files, or folders, 
as the Web interface. Have I created some sort of synchronization issue? 
 
If the file listing on the client does not display the same files as the Web User 
Interface, make sure that you have not set the GroupDrive client to Connect 
Offline. Also, set your GroupDrive Client Cache Settings to be Multi-User, which 
ensures that the client always reflects the most recent file status. 
 
What is the recommended cache setting on a PC? What will happen if it is 
set too low? 
 
We recommend that you set the cache size large enough so that it will hold at 
least the largest file you expect to store on your GroupDrive. If you set it too low, 
the GroupDrive client will eventually start thrashing and slow down due to too 
much disk activity. 
 
At the other hand, don't set it too big (for example, 100GB) because GroupDrive 
needs to inventory the cache contents periodically, which could take time if there 
is a huge cache. You could also try setting the cache at a percentage of disk 
space. 
  
If you want to have multiple users accessing the same files at the same time, 
and/or you always need the data updated on the server, then you should not 
cache any file information. If this is the case, on your Caching Options, turn off 
Cache Files and turn off Cache Recent File Information. You may also want to 
turn off Cache Directory Listings or at a minimum, have them expire quickly, 
for example, 5 seconds. Note: The system will run slower without caching, but 
your data will be updated more accurately. 
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When I create files while offline, and then go online, they seem to 
disappear from the mapped drive for 15-30 seconds before they appear 
again. I see them on the server immediately, but why do they disappear 
from the client? 
 
Sometimes if you use Offline Mode, files will not show up. Also, check your 
Cache settings in the Desktop Client; you'll want them to be set to Multi-User 
Mode, or set them to Custom Mode and turn off Directory Caching. This will 
ensure that the Desktop Client queries the remote server for new information 
whenever it needs it. 
 
How does the cache know to refresh? I deleted a few files and was 
expecting the cache to refresh to take that into account, but it didn't. I 
had to flush it myself. Is there any scenario where the cache knows to 
update or do I have to do it myself or set the expiration options? 
 
The cache will only update itself if you set the Expire Files After (X) 
Seconds/Expire Directory Listings After (X) Seconds feature or if you 
disable caching completely. To do this, launch the GroupDrive Site Manager, click 
the File menu, and then click Program Settings. Click the Cache Settings node 
and select the appropriate options. GroupDrive does not actively poll the remote 
server to see if the information has changed. 
 
I am copying two files, one is 9mb and the other is 50mb. I can copy the 
9mb file with no errors but with the 50mb file I am getting an error? 
 
Try increasing the cache size in GroupDrive. It's possible that the cache is filling 
up before the file is able to be transferred to the remote server. To increase the 
cache size, launch the GroupDrive Site Manager, click File>Program settings. 
Click the Cache Settings node and configure how much disk space to use for 
cache. 
 
Why does GroupDrive cache files when caching is not enabled? 
 
When you turn off caching in GroupDrive it will not cache the file. However 
GroupDrive will use the cache folder for a temporary "staging" area for files. It is 
similar to when you turn off caching in Internet Explorer. When you visit a 
Website, temporary Internet files are created. When you log off from the Internet 
the temporary Internet files will disappear. The same thing happens when you 
turn off caching in GroupDrive. When you download, upload, or open a file in 
GroupDrive, it will download a complete temporary file to your cache folder and 
use that file to work from. When you disconnect GroupDrive, that temporary file 
will disappear if caching is turned off. So GroupDrive isn't actually caching the file. 
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I received the Error: “Can't open cache file. Error (2) - The system cannot 
find the file specified”. 
 
This will usually happen if the GroupDrive Cache Directory does not exist, or if you 
do not have adequate rights to store files in the cache directory. Check the main 
GroupDrive Cache Folder Settings and make sure that the folder does exist. Also 
try increasing the cache size in GroupDrive. It's possible that the cache is filling up 
before the file is able to be transferred to the remote server. Lastly if you have 
antivirus real-time scanning enabled try disabling it. 
 
Can you give me a quick over view on the difference between the multi 
and single user setting? 
 
Single-User mode uses the cache as much as possible and doesn't check to see if 
the cache files are up to date with the server. Multi-User mode attempts to 
determine if cache files are up to date with the server. 
 
Why can't I see new files that are created by other users? 
 
Try flushing the cache from the Tray icon. To see updates from other users, you 
can select the Multi-User cache mode, or set directory listings to expire after a 
specified amount of time. 
 
Why can't I find a file on the server that should be there? 
Flush your directory cache. This can be done from the GroupDrive Site Manager or 
the Monitor application. 
 
 

 Visit our Knowledgebase for GroupDrive articles and more 
answers frequently asked questions. 

 

 

http://www.srthelpdesk.com/
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Automating Connections / Disconnections 

Connect to a Drive 

GroupDrive allows you to map a network drive to a site in the following ways: 

 Launch the GroupDrive Site Manager and set a persistent connection. This 
will allow you to connect to the specified site at system start or login. 

 Program Command Line Options. GroupDrive will accept a connection 
name as a parameter and perform the connection. 

 

This can be useful when you wish to automate a connection using a batch file. 
The connection name must be in quotes. For example, gcSiteManager.exe 
/s:“MySiteName”. To disconnect, you can specify the drive letter and /d. 
For example, gcSiteManager.exe X: /d will disconnect drive X:. 

 

To Disconnect a Drive 

1. Use the gcSiteManager.exe command line option listed above. 

2. Type the command NET USE X: /D where X: is the drive letter you wish 
to disconnect. 

 
 

Scripting or Batch Files 

GroupDrive can be used in a batch file to open a connection, copy files back and 
forth between the client and server, and then disconnect.  
 

Windows NT/2000/XP/2003 Example 
 
ECHO “Running FTP batch file!” 
start /wait /D"C:\program files\GroupDrive” gcSiteManager /s:“Microsoft” 
copy x:\dirmap.txtc:\ 
start /wait /D“C:\program files\GroupDrive” gcSiteManager X: /dECHO 
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Command Line Parameters 

Each command line parameter is optional, and if one is omitted then the existing 
value will be used. If the site name specified in the command line parameter 
doesn’t exist, then a new site will be created in the registry. In this case, you 
must specify enough parameters (username, password, and URL, to complete a 
valid connection. If a parameter value contains a space, you will need to enclose it 
in quotes, for example, /s:"site name".  
 
In our example below, we want to connect to the  South River Technologies 
site. Our user name is Fred and our password is Snowflake. The URL is 
www.SouthRiverTechnologies.com. 
 

 /s:<"sitename"> - This is the site name that you want to connect 
to. If this site does not exist then a new one will be created. 
Example - /s:SouthRiverTechnologies 

 /u:<username> – The user name to use for connecting to the 
site. Example - /u:Fred 

 /p:<password> – The password to use for connecting to the site. 
Example - /p:Snowflake 

 /url:<URL> – The URL to connect to. Example - 
/url:www.SouthRiverTechnologies.com 

 /d:<driveletter> – The drive letter to map to site. For example 
/d:X 

 /nosaveuserinfo – When specified, the username/password are 
not recorded in the registry. 

 /exp - Launch an Explorer window after connecting to the server. 
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GroupDrive Properties 

GroupDrive Context Menu  

The program provides a Context Menu for connected drives. Many of these options 
are also available for files and folders. 
 
To display the Context Menu from Explorer: 

1. Select a drive that is mapped. 

2. Right-click the mouse button. 
 

  
 
 
Open - Opens the drive. You can also double-click to open the drive. 
 
Explore - Allows you to explore the drive. 
 
Search - Launches the search dialog window. 
 
GroupDrive> 

 Clear cached files and folders - Immediately clears the GroupDrive 
cache. 

 Go Offline/Go Online - Allows you to work offline (no active connection 
to the server) or to go online. After you have worked offline, you must 
synchronize your files with the GroupDrive server. Use the Site General 
dialog to configure synchronization options. Files must be marked 
available for offline access. 

 Make Available Offline - Marks selected files and folders as available for 
offline access. 

 Synchronize Now - Immediately synchronizes the GroupDrive files. 
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 Disconnect - Disconnects from the GroupDrive server. 

 Manage Offline files and folders - Remove offline file and folder status. 

 E-mail to - Allows you to email a link to your files/folders to another user. 

 
Disconnect - Disconnects from the server. 
 
Copy - Copies the drive. 
 
Create Shortcut - Creates a shortcut to the drive. 
 
Rename - Allows you to rename the drive. 
 
Properties - Displays the Properties dialog.  
 

 

 The Context Menu will only appear for drives that are 
currently mapped. 

 For more information about Offline File Access, see the 
GroupDrive Offline File Access and Synchronization 
Features white paper.  

 

Drive Property Dialog 

The Drive Property dialog can be used to manage a drive that is mapped to a 
server.  

To Display the Drive Properties Dialog 

1. Right click Start. 

2. Select Explore. 

3. Select the drive icon from Explorer. 

4. Right-click on the drive and a context menu will be displayed. 

5. Select GroupDrive > Properties. 

http://southrivertech.com/docs
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Sharing, Linking and Permissions Overview 

Use GroupDrive's Sharing and Linking features to share and collaborate on 
information. When you Share your files with other GroupDrive users, and have 
them Link to your files, you create a collaborative workspace where multiple 
users can have access to a single copy of a file at any given time. 

 
There are three primary components to Sharing and Linking: 

 Sharing 

 Linking 

 Permissions 

 

Sharing 

Before other users can access a file or folder object, you must enable Sharing for 
that object. Once you have enabled sharing, you can then set the Permissions 
for that shared object. The permissions that you set determine each user's level of 
access for the file or folder. If you do not enable sharing for the file or folder 
object, other users will not have access to that object. 

Linking 

In order for a user to gain access to a file or folder object that you have shared, 
the user must Link to that object. This process is similar to creating a Windows 
Shortcut to a file. By creating a link to another GroupDrive user's share, you can 
access that user's document from within your GroupDrive workspace. 

Permissions 

Setting proper permissions on shared files and folders is very important. In 
addition to enabling sharing on file or folder objects that you want to share with 
other users, you must determine what type of access those users should be given. 
In general, if you simply want to share a file with someone so they can view it, 
then you would not want to grant them Write or Delete permissions because this 
would potentially allow them to delete the file. However, for example, if you are 
sharing a file for the purpose of collaborating, then you might want to grant Write 
access to the file so that the other team members can join in the collaboration 
process. Permissions determine what a user or group of users can and cannot do 
with your files and folders.
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GroupDrive Access Control is the process of granting users access (permissions) 
to file and folder objects. In GroupDrive Server, you set Permissions using an 
Access Control Entry to specify the user's level of access to your files. For 
example, you can set permissions on a file to let one user read the contents of a 
file, let another user make changes to the file, and prevent all other users from 
accessing the file. 
 
Every folder object and every file object in the GroupDrive file system has an 
Access Control List (ACL) associated with it that defines which users or groups 
have access to these objects. An access control list is comprised of one or more 
Access Control Entries (ACE) that define the access permissions for a specific 
user or group. 
 
Permissions can be Explicit or Inherited 

o Explicit - Permissions that are attached directly to an object, either when 
the object is created, or by user action. 

o Inherited - Permissions that are propagated to a child object from a 
parent object. By default, file and folder objects within a folder inherit the 
permissions from the parent folder when objects are created. You can 
allow users to use Inherited permissions by creating parent/child 
relationships. Inheritance makes it easy to assign and manage 
permissions because this feature automatically causes child objects to 
inherit all inheritable permissions from its parent object. For example, 
when you use Inherit, once you set the permissions for a folder, any new 
files created within that folder automatically inherit the permissions that 
are set for that folder. Using inherited permissions is not only easier to 
manage, it is also the most efficient method. Note: Inherited permissions 
cannot be edited. This prevents you from locking yourself out of your own 
folder.  

 
Permissions can be set for an individual or a group of users 
 
Permissions can be set for an individual user or a group of users. For better 
performance and ease of maintenance, use group permissions whenever possible. 
Public permissions determine what your world wide visitors can and cannot do 
with your files or folders, so use extreme care when setting these permissions. 
The Public Group includes all GroupDrive users as well as non-GroupDrive users. 
The Everyone Group includes all users on your GroupDrive Server. 
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 List of Permissions 

o R = Read/Download Files: When enabled, allows the user to view or 
download, run applications and open files for reading; however, they 
cannot modify files. 

o W = Write/Upload Files: When enabled, the user can upload and write 
new files. 

o A = Append/Replace Files:  When enabled, the user can upload new 
files over existing files. 

o D = Delete Files: When enabled, the user can delete files. 

o N = Rename Files: When enabled, the user can rename the file. 

o M = Create Subdirectories: When enabled, the user can create 
subdirectories or folders beneath the current directory. 

o R = Remove Subdirectories: When enabled, the user can remove 
subdirectories or folders beneath the current directory. 

o L = Can View Directory Listings: When enabled, the user can view the 
list of items in a folder. Without this permission, the files in the directory 
are hidden. 

o I = Apply rights to subdirectories: When enabled, all rights are applied 
to the subdirectory. 

o G = View Permissions: When enabled, the user can view the existing 
permissions on the folder. 

o S = Modify Permissions: When enabled, the user can change the 
permissions to the folder. 

 If you intend to share multiple files in the same folder, it is usually 
easier to share the entire folder so that the other collaborators can 
link to a single folder instead of each individual file. 

 Make sure that you have enabled sharing for your file or folder 
object and set permissions for users or groups. 

 It is a good practice to assign permissions to groups because it 
improves system performance when verifying the user's access to 
files. 

 Every file and folder object has an Access Control List (ACL) 
associated with it. The Access Control List is a list of Access 
Control Entries (ACE's) that define the permissions for each user 
or group on a file or folder object. 

 Inherited permissions cannot be edited. This prevents you from 
locking yourself out of your own folder. 
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Setting Permissions 

Permissions determine what a user or group of users can and cannot do with your 
files or folders. Permissions can be set for an individual user or a group of users. 
For better performance and ease of maintenance, use group permissions 
whenever possible. Public permissions determine what your world wide visitors 
can and cannot do with your file and folder objects, so be very careful when 
setting these permissions. The Public Group includes all GroupDrive users as well 
as non-GroupDrive users. The Everyone Group includes all users on your 
GroupDrive server. 
 
Note: We recommend that you read the Sharing, Linking and Permissions 
Overview before setting permissions on file or folder objects. 
 
To Set the Permissions on a File or Folder Object 

1. Right-click the file or folder object in GroupDrive. 

2. Select GroupDrive > Properties. 

3. Select the Permissions tab. 

4. Click Add. 

5. Click to select the user or group. (You can select more than one user or 
group using the Ctrl key.) 

6. Click Add. The chosen name will populate the text box. You may also type 
in the user name or group name; user names and group names must be 
separated with a semicolon. 

7. Click Check Names to verify that the list of names is valid. 

8. Click OK. The usernames/groups will be displayed. 

9. To set or change permissions, select the user or group from the list and 
make the appropriate permissions changes.
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10. Select Replace permissions on all child objects with entries shown 
here: 

o R = Read/Download Files: When enabled, allows the user 
to view or download, run applications and open files for 
reading; however, they cannot modify files. 

o W = Write/Upload Files: When enabled, the user can 
upload and write new files. 

o A = Append/Replace Files: When enabled, the user can 
upload new files over existing files. 

o D = Delete Files: When enabled, the user can delete files. 

o N = Rename Files: When enabled, the user can rename 
the file. 

o M = Create Subdirectories: When enabled, the user can 
create subdirectories or folders beneath the current 
directory. 

o R = Remove Subdirectories: When enabled, the user can 
remove subdirectories or folders beneath the current 
directory. 

o L = Can View Directory Listings: When enabled, the user 
can view the list of items in a folder. Without this 
permission, the files in the directory are hidden. 

o I = Apply rights to subdirectories: When enabled, all 
rights are applied to the subdirectory. 

o G = View Permissions: When enabled, the user can view 
the existing permissions on the folder. 

o S = Modify Permissions: When enabled, the user can 
change the permissions to the folder. 

 
Add: Adds the selected user or groups of users. 

Remove: Removes the permission entry.  

Select All: Allows you to select all the displayed permissions. 

Clear All: Allows you to clear all currently displayed permissions. 

Apply: Applies the changes made to the permissions tab. 

Cancel: Cancels any current changes and closes the tab. 

OK: Accepts any current changes to permissions. 
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Sharing 

Before other users can access a file or folder object, you must enable Sharing for 
that object. Once you have enabled sharing, you can then set the Permissions 
for that shared object. The permissions that you set determine each user's level of 
access for the file or folder. If you do not enable sharing for the file or folder 
object, other users will not have access to that object. 
 

To Share a File or Folder Object 

1. In your GroupDrive user directory, right-click the file or folder to display 
the Context menu. 

2. Select GroupDrive > Properties. 

3. Select the Sharing tab. 

4. Click Share this object to permit the file or folder to be shared with 
other users. (If you do not want share the file or folder object with other 
users, select Do not share this object.) 

5. Describe the file or folder object to be shared in the Comment text box. 

6. Click OK to apply the changes or Cancel to discard any changes and close 
the tab. 

 

Once you have shared a file or folder, you must also grant users 
permissions to access this shared file/folder.  
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Link Info 

The Link Info Properties tab displays information about the linked file or folder. 
You can also use the Link Info Properties tab to remove the link to a shared 
object.  
 
To Access the Link Info Dialog 

1. Select the linked file or folder object. 

2. Right-click on the object. 

3. Select Properties from the menu. 

4. Select the Link Info tab. 
 
Description: Displays the link description.      
 
Linked To: Displays the actual file or folder object that the link is pointing to. 
 
Remove Link: Removes the link to the file/folder object from your GroupDrive 
user directory. 
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Link To 

The Link To Properties tab is used to create a link to a file or folder object that 
has been shared with you by another user. Once a file or folder object has been 
shared with you, you can then create a link to the shared object, and that object 
will appear in your GroupDrive user directory. The Link To tab also displays 
information about the linked file or folder. 
 
Note: We recommend that you read the Sharing, Linking, and Permissions 
Overview topic. 
 

To display the Link To Properties tab 

1. Select the drive icon from Explorer. 

2. Right-click on the drive and a context menu will be displayed. 

3. Select Properties from the menu and the Drive Properties dialog will be 
displayed. 

4. Select the Link To tab. 

5. Click to select the file/folder that you wish to link to and the Link name 
text box will automatically be populated with the path of the file/folder. 
Alternatively, you may type the path in the Link name text box. 

6. Click Add. 

7. Click OK. 
 
Path: Displays where the actual file/folder resides. 
 
Description: Displays the link description. 
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E-mail To 

GroupDrive provides the ability to e-mail QuickLinks to files. A GroupDrive 
QuickLink is a special URL that points to a file or folder. The recipient of the e-
mail can simply click the QuickLink, included in the body of the e-mail, to access 
the file or folder. You can think of a QuickLink as a shortcut to a file or folder.  
 
The recipient of your e-mail QuickLink is not required to have a GroupDrive 
account to access the file. QuickLinks can also be configured to expire after a 
certain date/time or after a specified number of accesses. By default, the 
QuickLink is configured with Read permissions and is set to never expire. Many 
file servers have file size limits that can restrict the size of files/folders being e-
mailed between users.  
 

To E-Mail a QuickLink  

1. Right-click the file or folder object. 

2. Select GroupDrive > E-mail To. 

3. Configure the QuickLink properties: 

 Description - Type a description for this QuickLink. 

 Expires - Use the drop-down arrow to configure an expiration date 
for this QuickLink. 

 Permissions - By default, QuickLinks are set to Read-only. Click Edit 
to edit the permissions. 

 Password - Configure a password for this QuickLink (optional). 

4. Click Send e-mail to launch your default e-mail client and have the link 
pasted directly into the body of an e-mail message. 

5. Type the Address of the QuickLink recipient. If your e-mail client 
provides contact lists or mailing lists, you can select the address from 
these lists. 

6. Type the Subject of the e-mail. 

7. Send the e-mail. 
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 The recipient of the QuickLink is not required to have a 
GroupDrive account to access the file. 

 You must set permissions on the file/folder before the link is e-
mailed so that the recipient can access the file or folder. 
QuickLink permissions will not override existing permissions on 
file and folder object. For example, if you have set read-only 
permissions on a file, and you attempt to set read/write 
permissions on a QuickLink for that file, the permissions will 
default to read-only. 

 If you would prefer to use an e-mail client other than your 
default e-mail client or a Web-based e-mail such as Hotmail or 
Yahoo, you can click the Clipboard button to have the link 
copied to the Windows Clipboard. Once the links are copied to 
the Windows Clipboard, you can manually paste the links into 
your e-mail message. 
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Troubleshooting 

SRT Knowledgebase 

Visit our Knowledgebase to read helpdesk articles and answers to frequently 
asked questions.  

Reporting Problems 

To report a problem, visit the GroupDrive support site at 
http://www.SouthRiverTechnologies.com/support/.  
 
Please furnish our Support Engineers with the following information: 

1. The Windows platform you are running. 

2. The version of GroupDrive that you are using (this information can 
be found on the GroupDrive Site Manager Help menu>About). 

3. The URL of the server you were using when the problem occurred.  

4. A detailed description of the problem. Include file name and 
complete sub-directory name, if applicable. 

5. Attach a copy of the log file to your e-mail. 

 

For detailed instructions on producing a log file read the Enable File Logging topic. 
   

 

 

http://www.srthelpdesk.com/
http://www.SouthRiverTechnologies.com/support/
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Enabling File Logging 

When you report a problem to Support, we request that you attach a copy of your 
File Log to help us resolve your issue as quickly as possible. The procedure below 
will assist you in this process. 

Enabling File Logging   

1. Select File > Program Settings. 

2. Select the Logging tab. 

3. Click to Enable File Logging. 

4. Reconnect to the server. 

5. Re-create your problem. 

6. From the Logging tab, click View. 

7. Copy the log and paste it on the form at the Support Site. 

 

File Logging uses considerable space on your drive. We recommend that you 
do not enable file logging unless you are reporting a problem. 
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Removing the GroupDrive Client 

To remove the GroupDrive Desktop Client from your computer, you must be 
logged in with a user account that has administrator rights. 

 To Remove the GroupDrive Desktop Client 

1. Disconnect from the GroupDrive Server. 

2. Click Start on your desktop. 

3. Select Control Panel. 

4. Select Add or Remove Programs. 

5. Select GroupDrive.  

6. Select Remove. The uninstall wizard will be launched to remove the 
GroupDrive Desktop Client.  

 

 
You must restart Windows after removing the GroupDrive 
Desktop Client from your computer. 
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